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Welcome

Welcome to QuickBooks Enterprise Solutions financial software. Use this 
guide to learn how to use QuickBooks Enterprise Solutions and perform 
essential tasks. 

To install and set up Enterprise Solutions, refer to the QuickBooks 
Enterprise Solutions Installation and Setup Guide.

Audience of This Guide
The QuickBooks Enterprise Solutions User Guide has been prepared for 
accounting and business management professionals who manage 
business finances, inventory, customers, vendors, and employees.

Technical Support
Visit our Support website at www.qbes.com/support for support options 
and answers to frequently asked questions. Enterprise Solutions offers a 
Full Service Plan1 (sold separately) that includes product upgrades, 
technical support, training tools, and data protection services. Intuit 
reserves the right to limit each telephone contact to one hour and to one 
incident. Additional terms and conditions apply.

You can also visit the QuickBooks Enterprise Solutions User Community at 
www.qbes.com/community to connect with other Enterprise Solutions 
users and experts to ask questions and share advice.

1. The Full Service Plan is good for 12 months from your QuickBooks Enterprise Solutions purchase date or 
Full Service Plan renewal date. The Intuit support team is available weekdays from 4 A.M. - 7 P.M. Pacific 
time. Intuit reserves the right to limit each telephone contact to one hour and to one incident. Support 
availability subject to occasional downtime for systems and server maintenance, company events, 
observed U.S. holidays, and events beyond our control. Terms, conditions, pricing, service offerings, and 
availability of the Full Service Plan are subject to change at any time without notice. U.S. only. See terms 
and conditions at www.qbes.com/terms.	

www.qbes.com/support
www.qbes.com/community
www.qbes.com/terms
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t	 Learning Enterprise Solutionst

Read this chapter to learn QuickBooks Enterprise Solutions basics, 
including how to get around and how to get answers to your questions:

	l Getting Around Enterprise Solutions on page 8 describes the Home 
page and shows you how to find your data. 

	l Getting Answers to Your Questions on page 14 describes the variety of 
tools and resources that help you find answers to questions about 
QuickBooks Enterprise Solutions.

	l Enterprise Solutions Basics on page 20 explains important concepts 
you need to understand to use QuickBooks Enterprise Solutions 
effectively.

1
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Getting Around Enterprise Solutions
The Enterprise Solutions work area is designed to enable you to complete 
tasks quickly. Enterprise Solutions provides several ways for you to work; 
choose the method that works best for you.

Using the Home Page
When you open a company file, the Home page displays automatically. 

Figure 1 shows the Home page.

Figure 1	 The Home Page

The icon bar 
provides one-click 
access to 
QuickBooks 
centers and the 
Home page

The Home page 
provides a quick 
glance around 
the state of your 
business

The menu bar provides 
access to all tasks, 
features, and reporting 
functions

The In-product Help 
provides detailed 
instructions on how to 
perform tasks

The QuickBooks Coach walks 
you through business flows, 
and uses spotlights and tips to 
explain each step
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	 Getting Around Enterprise Solutions ﻿

The Home page provides a big picture of how all your essential business 
tasks fit together. Tasks are organized into logical categories (Customers, 
Vendors, Employees, Company, and Banking) with workflow arrows to help 
you learn how tasks relate to each other and to help you decide what to do 
next.

The workflow arrows indicate a logical progression of business tasks. 
However, these arrows do not restrict you from doing tasks in a different 
order, or an order that works better for your business needs.

To start a task, click the icon for the task you want to do. For example, to 
create an invoice, click the Invoices icon.

To return to the Home page, click the Home button in the icon bar.

The Home page also provides a quick glance around the state of your 
business. In the Account Balances list, you can see your current account 
balances, which are updated automatically as you do work.

The Home page is customized to display only those tasks and features you 
use, based on the questions you answer in the EasyStep interview. 
Functions you do not need do not clutter your workspace. However, if you 
decide to use these functions later, you can always add them back to the 
Home page. Go to the Edit menu and click Preferences. Click the Desktop 
View option and then click the Company Preferences tab.

If you are a new business owner or new to QuickBooks Enterprise Solutions, 
the QuickBooks Coach walks you through the business flows you see on 
your Home page. The QuickBooks Coach uses spotlights and tips to 
explain each step in your workflow. 

	 Note
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Finding Your Data in the QuickBooks Centers
Enterprise Solutions includes Centers where you can view and manage all 
of your customer, vendor, and employee information and transactions. 
You can go to one of the centers by clicking the appropriate button in the 
icon bar (on the left side of the toolbar).

Customer Center

The Customer Center is a lens into all your customer information. Without 
having to sift through multiple screens, you can view a list of all your 
customers and see pertinent information for each of them. Click on a 
customer’s name and you immediately see all the activity you have had 
with them as well as their contact information (phone number, fax 
number, and payment terms).

You can use the Customer Center to find out how much money a specific 
customer owes you or to view a list of all your customers with open 
balances. You can also look at your customer transactions (estimates, sales 
orders, invoices, credit memos, refunds, and so on) across all of your 
customers in the transactions list rather than having to run separate 
reports.
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Vendor Center

The Vendor Center gives you a complete picture about where your money 
is going. From one screen, you can see all your vendors and exactly what 
you owe them. Click on a vendor’s name to view an entire history with that 
vendor. You no longer need to run separate reports to see exactly how 
much business you are doing with each individual vendor. Also, you can 
sort your bills by due date so that you can stay on top of your finances.

If you need to talk to a vendor, click on the vendor name to see all the 
contact information. If a vendor calls you to follow up on a late payment, 
you can look up the bill quickly and see the check number and when you 
paid it.

Employee Center

The Employee Center lets you see exactly what you are paying each 
employee. Click on an employee’s name to view that person’s payroll 
history. If you need to get in touch with an employee, their contact 
information is right in front of you.

Payroll Center

If you subscribe to one of QuickBooks payroll services (additional fees 
apply), the Employee Center includes a Payroll Center. Use the Payroll 
Center to manage your payroll and payroll compliance.

Add-on services require subscription, EIN, or Internet access for certain 
features, including tax table updates and direct deposit.

The Payroll Center is a hub for managing all payroll activities. The Payroll 
Center reminds you of important payroll dates so you pay employees, pay 
your payroll liabilities, and file forms on time.

To visit the Payroll Center, click the Employee Center button on the icon 
bar and click the Payroll tab.

	 Note
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Getting a Real-Time View of Your Business
Use Company Snapshot to get a real-time view of your business on one 
page. You can see a trend graph of your income and expenses, your 
account balances, customers who owe you money, and vendors you need 
to pay. To open the Company Snapshot, go to the Company menu and 
click Company Snapshot.

Displaying Multiple Windows
Enterprise Solutions is preset to show multiple windows at the same time. 
By doing so, you can easily navigate between tasks as well as compare 
data in multiple windows. When you open a window, it opens to a preset 
size and location. You can resize and move each window as you see fit.

Depending on how you size or arrange the windows, some windows may 
not be visible. Use the Window menu to view a list of the open windows. 
Click the window name in the list to bring it to the front.

Alternatively, you can display the Open Window List to have the list of 
open windows always visible on the left side of the application window. Go 
to the View menu and click Open Window List. If you prefer to view only 
one window at a time, got to the View menu and click One Window.

If your work area becomes too cluttered with windows that you have open, 
you can close them all at once instead of closing them one at a time. To 
close all windows, go to the Window menu and click Close All.

When you close your company file at the end of the day, it is good practice 
to close all windows that you have open. The next time you open your 
company file, all the windows you had open when you closed your 
company file will re-open. If you forget to close open windows when you 
exit Enterprise Solutions, hold down the Alt key while opening your 
company file. Your company file displays with no windows open in your 
work area.

	 Tip
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Adding Icons to the Icon Bar

For quick access to the areas of Enterprise Solutions you use most, you can 

customize the icon bar by adding many of the features and reports that 
you use most frequently.

Figure 2	 Adding Icons to the Icon Bar

To add a shortcut for a window, such as Enter Bills, open that form and 
then display the View menu. The window you open appears as an option 
on the View menu.

Some windows cannot be added to the icon bar.

You can add, re-arrange, and remove shortcuts from the icon bar to suit 
your needs. To modify the icon bar, go to the View menu and click 
Customize Icon Bar.

	 Note
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Getting Answers to Your Questions
Enterprise Solutions provides a variety of tools and resources to help you 
find answers to questions you might have. 

	 Use the in-product l Help for step-by-step instructions on using 
Enterprise Solutions. Refer to Using In-Product Help on page 15.

	 Learn how to do common tasks by watching interactive, in-product l 
tutorials. Refer to Using the Learning Center1 on page 18.

	 Connect with other users and experts in the l Live Community. Refer to 
Using the Live Community on page 19.

	 Visit l www.qbes.com/localhelp to find a local Intuit Solution Provider 
for on-site assistance. You can save time and money by using 
professionals to help you set up Enterprise Solutions, migrate your 
existing data into Enterprise Solutions, integrate Enterprise Solutions 
with your other software systems, and set up reports so you can better 
understand the health of your business. 

	 Visit l www.qbes.com to contact the Intuit support team.

1. Internet access required for online services.

www.qbes.com/localhelp
www.qbes.com
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Using In-Product Help
In-product Help provides background information and instructions for 
doing Enterprise Solutions tasks. You can access the help content and 
features in several ways.

To use in-product Help, go to the Help menu and click QuickBooks Help or 
click the Live community button in the icon bar and then click the Help 
tab.

Viewing Help for a Window You Have Open

If you are unsure how to use a particular window, press the F1 key on your 
keyboard to get help. (You can also click the Help button in the window, if 
one is present.) These help topics provide answers to questions such as:

What can I use this form for?l 

What does this button do?l 

What kind of information is displayed in this column?l 

What happens when I select this option?l 

How do I complete a task?l 
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Information in the Relevant Topics Tab

Each time you open a new QuickBooks window, the links in the Relevant 
Topics tab change so that they apply to the active window.

Relevant Help topics explain how to use the window, and can include:

Tutorials that show you how to complete tasksl 

Business process overviewsl 

Step-by-step instructionsl 

Planning and best practice suggestionsl 

Troubleshooting informationl 

If you do not see the information you need in the Relevant Topics tab, use 
the Search tab to find the topic.
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Using Help Search

The in-product Help is quite extensive. If you do not see the information 
you are looking for in the Relevant Topics list, use the Search to find 
answers to your questions quickly:

Click the 1	 Search tab. 

In the Search field, type a short phrase (containing a noun and verb) 2	
that describes the information you want. For example, add a 
customer or How do I add a customer?

Click the search arrow. Search returns a maximum of 15 topics based 3	
on the words you enter.

Figure 3 shows the Search tab 

Figure 3	 Help Search

Be as specific as possible. For example, if you want to know how to add a 
customer, entering just customer returns topics ranging from adding a 
customer to deleting a customer and more. Instead, enter add 
customer or how do I add a new customer?

Enter a shorter search phrase or question. For example, how do I add 
customers returns better results than How do I add new customers and 
vendors.

In the Search field, type a 
short phrase that describes 
the information you want 
and click the arrow

Topics relevant to the 
information you request 
display in topics found

Click a topic to view it

	 Tips
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Try using different words and phrases. For example, if you are looking for 
something about installing an Enterprise Solutions update, enter update 
Enterprise Solutions.

Do not use abbreviations. Use the full word instead.

Using the Learning Center
As you begin using Enterprise Solutions, one of the first things you see is 
the Learning Center. The Learning Center provides interactive tutorials to 
help you learn how to use Enterprise Solutions. After you complete a 
tutorial, a checkmark displays next to its title. 

To open the Learning Center, go to the Help menu and click Learning 
Center Tutorials. You can also access the tutorials from the QuickBooks 
Coach.

Using the QuickBooks Coach
If you are new to Enterprise Solutions, you can explore the Home page 
with the QuickBooks Coach to learn more about your business workflows. 
Click Start Working to turn on explore mode. Then mouse over and click 
the Coach icons to see:

	 Details about your workflowsl 

	 Spotlights that show you the steps in a flow, with tips to complete l 
each step

	 Bold numbers, highlighted lines, and arrows show you the order in l 
which to do your work
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Using the Live Community
The Live Community enables you to ask other users and experts for help 
and get answers fast, right inside Enterprise Solutions. Use Live 
Community to ask any question, from how-to questions about 
Enterprise Solutions to advice on how to run and grow your business. To 
use Live Community, go to the Help menu and click Live Community.

Type your question here and 
click Ask My Question. 
Enterprise Solutions notifies 
you when someone answers 
your question.

Previously asked questions 
that some one has answered 
display here

Questions that have yet to 
receive answers from the 
community display here.  
Click a link to post an answer.
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Enterprise Solutions Basics
To take full advantage of Enterprise Solutions, there are some important 
concepts you need to understand.

Working with Lists
You use information stored in lists to fill out most QuickBooks forms. For 
example, to create an invoice, you choose the customer name from your 
Customer & Job list. Enterprise Solutions automatically enters the 
customer information on the form for you. This saves you time and 
prevents typing errors. You can also change the information directly on the 
form as needed. Lists are easy to set up, but do require careful planning.

Depending on the type of list you want to use, you can get the list in one of 
two ways:

	 QuickBooks Centersl 

Your Customers & Jobs, Vendors, and Employees lists are available in 
the Customer, Vendor, and Employee Center. Click the appropriate 
QuickBooks Center button on the icon bar to go to a QuickBooks 
Center. Then, click the tab for your list.

	 List Windowsl 

Other lists, such as the Chart of Accounts and Item List, appear in 
separate windows. To view one of these lists, click the Lists menu and 
then click the list you want. To enter information in these fields, use 
the menu button at the bottom of the list to add, edit, or delete list 
items. The Lists menu also provides access to features associated with 
the list.

The more detail you enter for each list item, the more information 
Enterprise Solutions can use to pre-populate forms, track financial data, 
and display useful reports about your business. Another advantage of lists 
is that common tasks like adding list entries, editing list information, and 
deleting list entries are performed the same way.
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Entering List Information as You Work

There are two basic methods you can use to enter list information. You can 
enter account, customer, vendor, product and service information before 
you enter transactions, or you can enter this information as you use the 
product.

If you prefer to enter information as you use the product to perform your 
daily tasks, Enterprise Solutions prompts you to immediately set up any 
entry it does not know about. You can always add more information to the 
record at a later time from the appropriate list.

Writing Checks Versus Paying Bills
You can manage and pay your bills in two ways:

	 Write checks to pay bills now. l 

Use the Write Checks window and assign the amounts to appropriate 
expense accounts. Intuit recommends this method when you do not 
receive a bill; for example, when you go to the store and write a check 
and then you need to record that expense in Enterprise Solutions. You 
can also use Write Checks to pay a bill as soon as you receive it, as 
long as you do not need to track the bill.

Note: Use the method above if you are using accrual-based 
accounting methods.

	 Enter bills when you receive them and pay them later. l 

Use the Enter Bills window to enter bills when you receive them. Then 
use the Pay Bills window to pay bills when they are due. You can set up 
Enterprise Solutions to remind you to pay bills when they are due. 
Using this method, you keep your money in your business for as long 
as possible. You might still use a check to pay the bill, but this method 
enables you to track how much money you owe. And at any time, you 
can run reports to analyze unpaid bills for information such as to 
which vendors you owe money.

Note: Do not simply write a check in the Write Checks window to pay 
bills that you entered in the accounts payable register or the Enter 
Bills window. Use the Pay Bills window to pay these bills.
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What Happens When You Record a Bill Payment?

If you paid by:

	 Checkl  — Enterprise Solutions prepares one check for each vendor and 
records the checks in the check register with BILLPMT in the Type 
field.

	l Credit card — Enterprise Solutions records a charge for each vendor in 
your credit card register.

	l Cash — Enterprise Solutions records a payment for each vendor in 
your cash account register.

	l Online banking payment — Enterprise Solutions prepares one online 
banking payment instruction for each vendor and records the 
payments in the check register with BILLPMT in the Type field.

In each scenario, Enterprise Solutions records the payment to each vendor 
in the accounts payable register. The amount you paid appears in the 
Payment column.

Using Multiple Currencies
Enterprise Solutions supports all global currencies so you can work with 
international vendors and customers. You can assign a currency to 
customers, vendors, price levels, bank accounts, credit card accounts, and 
accounts receivable/accounts payable accounts. Other account types, like 
income and expense accounts, always use your home currency.

Multiple currency affects many accounts and balances in your company 
file and is irreversible. Intuit recommends that you back up your company 
file before turning on Multiple Currencies.

To turn on Multiple Currencies:t 

Go to the 1	 Edit menu and click Preferences.

In the 2	 Preferences list, click Multiple Currencies.

Click the 3	 Company Preferences tab.

Click 4	 Yes, I use two or more currencies. 

	 Important
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Select your home currency from the drop-down list.5	

		  Your home currency is the currency of the country where your 
business is physically located. In most cases, the home currency is 
the US dollar (USD). 

If you choose to set a home currency other than the US dollar, Intuit 
services such as payroll and online banking will not be available; these 
services are only available in US dollars.

For more information about Multiple Currencies, refer to the In-product 
Help.

Using the Sample Company Files
Enterprise Solutions includes several sample company files with which you 
can practice to enter pretend data, run reports, and explore features. To 
open a sample company file, go to the File menu, click Open or Restore 
Company, and then click a sample company file from the list.

	 Important
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	t Setting Up Your Businesst

Read this chapter to learn essential tasks for setting up your business: 

	l Customizing Enterprise Solutions on page 26 describes how to 
customize the way you work.

	l Adding an Account on page 28 describes how to add accounts.

	l Adding Customers on page 33 describes how to add customers.

	l Adding Vendors on page 35 describes how to add vendors.

	l Adding Items on page 36 describes how to add items. 

	l Setting Up Sales Tax on page 40 describes how to set up sales tax.

	l Setting Up Payroll on page 49 describes how to set up Payroll.

	l Setting Up Employees on page 52 describes how to set up employees.

2
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Customizing Enterprise Solutions
Preferences customize Enterprise Solutions to suit the needs of your 
business and your personal style of working. From the Preferences 
window, you can define preferences in over a dozen different categories.

For example, you can configure general preferences such as whether or not 
Enterprise Solutions prompts you before editing or deleting a transaction, 
or which date it uses for new transactions. Or, you can configure 
accounting-specific preferences such as how to display accounts and 
subaccounts. Figure 4 shows the Preference options.

Figure 4	 Modifying Preferences

Use Company Preferences to set global preferences that affect all users of 
the company file. Only the QuickBooks Administrator can set up or modify 
company preferences.

Use My Preferences to set personal QuickBooks preferences, such as using 
the Enter key instead of the Tab key to move between fields.
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To view and set preference options:t 

Go to the 1	 Edit menu and click Preferences.

In the 2	 Preferences window, change any of the general preferences. 
These preferences determine how Enterprise Solutions behaves.

To display the preferences for specific categories, click the 3	
appropriate category in the list on the left. For example, to set 
preferences for reporting functions, click Reports and Graphs.

On the 4	 My Preferences tab for the particular feature area, enter the 
changes and settings you want. These settings affect only your 
Enterprise Solutions sessions, not those of other users.

Do one of the following:5	

	 Click l OK to close the Preferences window and save your 
changes.

	 Click another feature area in the scroll box to enter other l

preferences. Click Yes when prompted to save your changes.

Click 6	 OK.
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Adding an Account
When you set up your company file, Enterprise Solutions sets up certain 
accounts for you automatically. However, as your business grows or 
changes, you might need to add new accounts to your chart of accounts to 
better organize your finances. Or, you might need an account that was not 
provided during setup. For example, you might want to create expense 
accounts to track office supply purchases separately from advertising 
costs.

To set up your accounts correctly, you might need to get help from an 
accounting professional.

To add an account:t 

Go to the 1	 Lists menu and click Chart of Accounts.

Click the 2	 Account button and then click New.

In the 3	 Add New Account: Choose Account Type window, select 
the type of account you want to create and then click Continue.

		  Refer to Table 1 on page 30 for a description of the different types 
of income, expense, and balance sheet accounts.

Enter the account’s name in the 4	 Account Name field. This name 
appears on all your company financial statements.

If you want to make this account a subaccount of another account, 5	
click the Subaccount of checkbox. From the drop-down list, click the 
account that will be the higher-level account for this subaccount.

(Optional) Enter a short description, note, bank account number, or 6	
credit card number, depending on the type of account you are 
adding.

For income and expense accounts7	 . From the Tax Line Mapping 
drop-down list, click the appropriate tax line or <Not tax-related\>.

For balance sheet accounts8	 . Enter an opening balance based on the 
account’s balance as of your QuickBooks start date. Generally, you 
should enter any balance sheet balances as of the day before your 
start date. That way it is all exactly correct at the opening of your 
start date. If you are putting money into the account with a 

	 Note
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transaction, do not use the opening balance field, as this will create 
an additional transaction. If you are not sure of the balance, you 
can leave the field blank and enter the information later. Click OK 
when finished.

Click 9	 Save & Close or Save & New to add another account.

You can also add accounts as you perform everyday tasks. For example, if 
you are writing a check and enter an account name that has not yet been 
set up in Enterprise Solutions, you will be prompted to set up the new 
account. If you need to make changes to your account information, 
double-click the account in the Chart of Accounts list. The Edit Account 
window opens; make your changes and click OK.

Using Subaccounts
When you need more detail about what is going on in an account, you can 
divide the account into one or more subaccounts, which let you track 
several related types of income or expenses independently yet keep them 
all under the umbrella of a single parent account. Subaccounts appear 
indented immediately below their parent account in your chart of 
accounts. If you create subaccounts, it is best not to post anything to the 
parent account. For example, if your business has substantial advertising 
expenses, you might decide to divide your Advertising expense account 
into several subaccounts, such as Newspaper Ads, Signs, Yellow Pages, and 
Direct Mailings.

Creating Brand New Accounts
When you create a brand new account, leave the opening balance at zero. 
The opening balance will be created automatically when you transfer 
funds from another account.

Account Types
There are two main types of accounts in the chart of accounts:

	 Income and expense accountsl 

	 Balance sheet accountsl 

	 Note
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Income and Expense Accounts
Income and expense accounts track the sources of your income and the 
purpose of each expense. When you record transactions in one of your 
balance sheet accounts, you usually assign the amount of the transaction 
to one or more income or expense accounts. For example, not only do you 
record that you took money out of your checking account, but you keep 
track of what you spent the money on (utilities or office supplies). Table 1 
lists income and expense accounts and describes when to use them.

Account Type Purpose

Income Categorizes money earned from normal business 
operations, such as product sales, service sales, and 
discounts to customers.

Other Income Categorizes money your business earns that is unrelated 
to normal business operations, such as dividend income, 
interest income, and insurance reimbursements.

Expense Categorizes money spent in the course of normal business 
operations, such as advertising and promotion, office 
supplies, insurance, legal fees, charitable contributions, 
and rent.

Other Expense Categorizes money your business spends that is unrelated 
to normal business operations, such as corporation taxes 
and penalties and legal settlements.

Cost of Goods 
Sold

Tracks the direct costs to produce the items that your 
business sells, such as cost of materials, cost of labor, 
subcontractors, and shipping.

Table 1	 Income and Expense Account Types

Enterprise Solutions does not display balances for income and expense 
accounts in the chart of accounts. To see these balances, go to the Reports 
menu, click Report Center, and then click the Company & Financial 
category. You can also double-click the income or expense account in the 
chart of accounts to display a QuickReport.

The chart of accounts is a complete list of your business accounts and their 
balances. You use a chart of accounts to track how much money your 
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company has, how much money it owes, how much money is coming in, 
and how much is going out.

The IRS recommends opening a business checking account as one of the 
first things you do when starting a new business. Intuit highly 
recommends associating your income and expense accounts with the 
appropriate tax lines for your tax forms. Consult with your accountant if 
you need more information about which tax forms to use and to which tax 
lines to map each account.

Balance Sheet Accounts
Enterprise Solutions provides several types of balance sheet accounts to 
choose from as you create and add to your chart of accounts. Use the type 
of account that best describes the type of data you are tracking.

Table 2 lists the balance sheet accounts and when to use them.

Account Type Purpose

Bank Tracks money you have in your cash accounts. 
Create one for each cash account, such as petty 
cash, checking, savings, and money market.

Tip: When you create a new bank account, 
leave the opening balance at zero. The opening 
balance is created automatically when you 
transfer funds from another account.

Accounts Receivable (A/R) Tracks money your customers owe you on 
unpaid invoices. Most businesses require only 
the A/R account that Enterprise Solutions 
automatically creates after you create your first 
invoice.

Other Current Asset Tracks the value of things that you can convert 
to cash or use up within one year, such as 
prepaid expenses, employee cash advances, 
inventory, and loans from your business.

	 Important
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Account Type Purpose

Fixed Asset Tracks the value of significant items (consult 
your tax professional for a minimum dollar 
amount) that have a useful life of more than 
one year, such as buildings, land, machinery 
and equipment, and vehicles.

Other Asset Tracks the value of things that are neither Fixed 
Assets nor Other Current Assets, such as 
Goodwill, long-term notes receivable, and 
security deposits paid.

Accounts Payable (AP) Tracks money you owe to vendors for purchases 
made on credit. Most businesses require only 
the A/P account that Enterprise Solutions 
automatically creates after you create your first 
invoice.

Credit Card Tracks credit card purchases, bills, and 
payments. Create one for each credit card your 
business uses.

Other Current Liability Tracks money your business owes and expects 
to pay within one year, such as sales tax, 
security deposits/retainers from customers, and 
payroll taxes.

Long-Term Liability Tracks money your business owes and expects 
to pay back over more than one year, such as 
mortgages, long-term loans, and notes payable.

Equity Tracks money invested in, or money taken out 
of, the business by owners or shareholders. 
Payroll and reimbursable expenses should not 
be included.

Table 2	 Balance Sheet Account Types
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Adding Customers
Customers (also called clients or members) are the lifeline of your business. 
By entering detailed information in Enterprise Solutions about the people 
and companies to whom you sell your products and services, you can 
personalize their bills, send invoices easily, and quickly view the status of 
their accounts. You can add new customers at any time.

Typing in customer data for hundreds of customers can be a tedious task. 
If you use Microsoft Outlook, you can import your existing customer 
information into Enterprise Solutions instead of entering it manually. Refer 
to the in-product Help for instructions on how to prepare your customer 
data file for importing into Enterprise Solutions. 

To add a customer:t 

Click the 1	 Customer Center icon at the top of the QuickBooks 
Enterprise Solutions window.

Click 2	 New Customer & Job and then click New Customer.

On the 3	 Address Info tab, enter all the data that you have about the 
customer, including their name, Bill To and Ship To addresses, and 
additional contact information.

Complete the 4	 Additional Info and Payment Info tabs, as 
appropriate. If you want to add additional fields to the form, click 
Define Fields to customize the form.

Click 5	 OK or Next (if you want to enter another customer).

	 Tip
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You can also add customers as you perform your everyday tasks. For 
example, if you enter the name of a new customer when filling out an 
invoice, Enterprise Solutions prompts you to enter information about this 
customer. You can choose from two quick setup options:

	 Quick Addl  adds just the name to the list. You must add the details 
later.

	l Set Up enables you to enter additional information (such as phone 
number, fax number, and alternate contact) to the list you choose.

If you are performing more than one job for a customer, you can track the 
jobs individually by adding new jobs under the customer’s name in the 
Customers & Jobs list. That way, you can create reports that show the 
income and expenses for each job. To add a job, click New Customer & 
Job and then click Add Job.

If you need to add several customers to your company file, consider using 
the Add/Edit Multiple List Entries feature to quickly enter multiple 
customers at one time. For more information, see QuickBooks Help and 
search for “Add and edit multiple customers.”
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Adding Vendors
The vendor list holds information about the people and companies you 
buy goods and services from to run your business; for example, this list 
could include the phone company, your office supplies vendor, and your 
tax board. You can add new vendors at any time.

Typing in vendor data for hundreds of vendors can be a tedious task. If you 
use Microsoft Outlook, you can import your existing vendor information 
into Enterprise Solutions instead of entering it manually. Refer to the 
in-product Help for instructions.

To add a vendor:t 

Click the 1	 Vendor Center icon at the top of the 
QuickBooks Enterprise Solutions window.

Click 2	 New Vendor.

On the 3	 Address Info tab, enter all the data that you have about the 
vendor, including their name, address, and additional contact 
information.

If you owe this vendor money as of your company’s start date, 4	
enter the amount in the Opening Balance field.

Click the 5	 Additional Info tab and complete the form, as 
appropriate. If you want to add additional fields to the form, click 
Define Fields to customize the form.

Click 6	 OK or Next (if you want to enter another vendor).

You can also add vendors as you perform your everyday tasks. For example, 
if you enter the name of a new vendor when paying a bill, Enterprise 
Solutions prompts you to enter information about this vendor. You can 
choose from two quick setup options:

	 Quick Addl  adds just the name to the list. You must add the details 
later.

	 Set Up enables you to enter additional information (such as phone l 
number, fax number, and alternate contact) to the list you choose.

	 Tip
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If you need to add several vendors to your company file, consider using the 
Import/Export functions to enter multiple vendors at one time. See the 
in-product Help for instructions on how to import lists.

Adding Items
An item is anything that might appear as a line item on an invoice, 
including subtotals, discounts, and sales tax, as well as the products and/or 
services that you sell. You enter items on your invoices and sales receipts. 
For example, a writing consultant might set up one item for editing 
services with an hourly rate, and another item for writing services with a 
different hourly rate. On an invoice, the items would be entered with the 
number of hours worked as the quantity.

While providing a quick means of data entry, items also handle the 
behind-the-scenes accounting. When you create an item you link it to an 
account. When the item is used on a form it posts an entry to that account 
and another to the appropriate accounts receivable, accounts payable, 
checking, or other account.

When you choose an item from the Item list, Enterprise Solutions fills in a 
description of the line item and calculates its amount for you.

Enterprise Solutions provides several different types of items, described in 
Table 3, below. Some items, such as service or inventory part items, help 
you record the services and products your business sells. Other items, such 
as the subtotal or discount item, are used to perform calculations on the 
amounts in a sale.

Item Type Purpose

Service Use for services you either charge for or purchase, like 
specialized labor, consulting hours, and professional 
fees.

Inventory Part Use for goods you purchase, track as inventory, and 
resell.

Inventory Assembly Use for assembled goods you build or purchase, track 
as inventory, and resell.
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Item Type Purpose

Non-Inventory Part Use for goods you buy but do not track, like office 
supplies, or materials you buy for a specific job that 
you charge back to your customer.

Other Charge Use for miscellaneous labor, material, or part 
charges, such as delivery charges, setup fees, and 
service charges.

Subtotal Use to total all items above it on a form, up to the last 
subtotal. Useful for applying a percentage discount 
or surcharge to several items

Group Use to quickly enter a group of individual items on an 
invoice.

Discount Use to subtract a percentage or fixed amount from a 
total or subtotal. Do not use this item type for an 
early payment discount; for an early payment 
discount, use the Set Discount feature in the Receive 
Payments window.

Payment Use to record a partial payment you received at the 
time of the sale. It reduces the amount owed on an 
invoice.

Sales Tax Item Use to calculate a single sales tax at a specific rate 
that you pay to a single tax agency.

Sales Tax Group Use to calculate and individually track two or more 
sales tax items that apply to the same sale. The 
customer sees only the total sales tax.

Table 3	 Item Types
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To add an item:t 

Go to the 1	 Lists menu and click Item List.

Click 2	 Item at the bottom of the list and then click New.

Click the 3	 Type drop-down arrow and choose the type of item you 
want to create.

Enter an item name as you want it to appear on purchase and sales 4	
forms.

Enter the description that you want to appear on sales forms when 5	
you use the payment item.

In the 6	 Rate field, enter the amount you want to charge for the item 
or leave as zero, if the rate varies.

In the 7	 Account field, choose the account that is associated with 
this item. (In most cases, you will assign the item to an income 
account.)

In the 8	 Tax Code list, select the appropriate sales tax code or create 
a new one. If you do not see the Tax Code list, you must turn on the 
tax preference in the Sales Tax area under Edit/Preferences.

Click 9	 OK or Next (if you want to enter another item).
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Why are Item Types Important?
Although you can use items as a quick means of entering data, items fulfill 
a much more important role into handling the behind-the-scenes 
accounting.

When you create an item, you link it to an account; when the item is used 
on a form, it posts an entry to that account and another entry to the 
appropriate accounts receivable, accounts payable, checking, fixed asset, 
or other account.

While items are easy to set up, you should spend some time deciding how 
they can best work for you before you start setting them up and using 
them. Use your current list of services and products as a starting point. 
Consider how much detail you want on your invoices or statements and set 
up your items with that level of detail in mind. For example, if you are a 
seamstress who creates and sells home accessories, you can set up a single 
item and charge a flat rate for a certain size of couch pillow, or you can 
break that pillow down further into labor and materials.

Furthermore, Enterprise Solutions provides many useful reports that break 
information down by the goods or services you purchase and sell. That 
way, you can quickly find out:

	 How much income your items bring inl 

	 What you are spending to purchase itemsl 

	 How well you estimate the cost of itemsl 

	 How much time you spent on each type of job or iteml 
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Setting Up Sales Tax
Depending on where you do business, you might be required to collect 
sales tax for the products or services you sell. If you collect sales tax, you 
must pay it to a tax agency on a regular schedule. Enterprise Solutions 
helps automate your sales tax tracking so you can keep accurate records 
about the sales tax you collect and pay.

You must follow the rules and regulations for collecting and paying sales 
tax in your tax district (city, county, state).

Understanding How Sales Tax Works
Enterprise Solutions uses sales tax codes to track the taxable or non-
taxable status of both the items you sell (products and services) and your 
customers. If your tax agency requires you to report the reasons why 
particular sales are taxable or non-taxable, the sales tax codes that you 
assign to your items and customers enable you to run reports that provide 
this information for your sales tax return.

Enterprise Solutions uses sales tax items to calculate and add sales tax 
charges when you make a taxable sale. When you set up a sales tax item, 
you assign a sales tax rate to it and associate it with the tax agency to 
which you pay the sales tax. All of the sales tax items you set up are in your 
Item list. Once you have set up sales tax, Enterprise Solutions 
automatically applies the appropriate sales tax rate to the sale of your 
taxable items.

	 Important
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Before You Start Setting Up Sales Tax
To set up sales tax in Enterprise Solutions, you need to know the following 
sales tax requirements for the locations where you sell your products and 
services:

	 Sales tax ratesl  for each tax district (a city, county, or state that has a 
sales tax) in which you sell. You may have multiple sales tax rates that 
you need to charge, for example, sales tax for both a county and a 
state.

	l Tax agencies to which you pay the collected sales tax for each of 
those district taxes.

You can find your sales tax requirements (rates, payment schedules, and so 
on) online at your state sales tax website. Intuit has provided access to 
these websites from the in-product Help. Go to the Help menu and click 
QuickBooks Help. In the Search box, type Finding the sales tax 
rates and requirements for your business and press Enter. Click 
the topic to open it and then click the link for your state.

Term How it relates to sales tax setup

Sales Tax Rate The percentage charged for sales tax by the tax 
district. For each different district/rate 
combination, you need to set up a new sales tax 
item. For example, you might sell in three counties 
that all charge the same sales tax rate, but you 
need a separate sales tax item for each county, 
even though the sales tax rate is the same. This 
enables you to track the amounts of sales tax you 
collect for each tax district.

Sales Tax Item An item that is used to calculate the appropriate 
sales tax for a sale. A sales tax item includes a 
sales tax rate and a tax agency. When you sell 
taxable items, you charge the appropriate sales 
tax rate by assigning a sales tax item to each sale.
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Term How it relates to sales tax setup

Sales Tax Group Item An item that groups multiple sales tax items so 
you can charge only one rate on your sales. For 
example, the location where you sell might 
require you to charge both a county and a state 
sales tax. However, customers are used to seeing 
one sales tax rate on sales. You would set up a 
sales tax group item that combines those two 
sales tax rates, for example 1% for the county 
and 7% for the state, to create a single, sales tax 
group item with a rate of 8%. You would apply 
this sales tax group item to your taxable sales for 
that county.

Sales Tax Code The identifier that Enterprise Solutions uses to 
track the taxable and non-taxable status of both 
the products and services you sell, and the 
customers to whom you sell these items. For 
example, a customer that is a non-profit 
organization might have a non-taxable status. 
You would not charge sales tax for anything you 
sell to this particular customer. 

Tax District A town, city, county, or state that charges sales 
tax. A tax district might also include a municipal 
or special jurisdiction, such as a Mass Transit tax 
or a parish in Louisiana.

Tax Agency The government office that determines the 
requirements for sales tax collection or payment. 
You might need to pay your collected sales tax to 
one or more tax agencies, depending on the 
requirements for the locations (tax districts) 
where you do business. Tax agencies are set up as 
vendors because you make payments to them. A 
tax agency is sometimes called a tax authority.

Table 4	 Sales Tax Terms
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Setting Sales Tax Preferences

Figure 5 shows the sales tax preferences.

Figure 5	 Setting Sales Tax Preferences

Setting Up Sales Tax
Setting up sales tax is a multi-step process, divided into three main parts:

	 Part 1l : Sales tax payment schedule

	l Part 2: Sales tax codes to track taxable status of items and customers

	l Part 3: Sales tax items, rates, and tax agencies
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Part 1: Sales Tax Payment Schedule
In this procedure, you turn on sales tax and then set up information about 
when you need to pay your tax agency.

To set up your sales tax payment schedule:t 

Go to the 1	 Edit menu and click Preferences.

Click 2	 Sales Tax in the list on the left.

Click the 3	 Company Preferences tab.

For the question 4	 Do You Charge Sales Tax? click Yes.

Select when you owe sales tax to the tax agency, as specified by 5	
your tax agency:

	 Select l As of invoice date if your tax agency stipulates that you 
owe sales tax from the moment you write an invoice or make a 
sale.

	 Select l Upon receipt of payment if your tax agency stipulates 
that you owe sales tax when you receive the payment from a 
customer.

Note: This preference overrides the accounting basis you have set 
for your company and for your report preferences (for example, if 
your report preference is set to cash but you select accrual here, 
your sales tax reports will be accrual-based).

Select how often you pay sales tax to the tax agency, as specified by 6	
your tax agency. If you do not know which time period to choose, 
check your sales tax license. It should indicate the payment schedule 
that you need to use.

If you collect sales tax for multiple tax agencies that require payment at 
different intervals, use the payment interval you use most frequently. 
When you run your sales tax reports and make your payments, you will be 
able to see which amounts are due on which dates.

The time interval you select to pay your sales tax is reflected in the period 
of time covered by your sales tax reports and sets reminders to pay your 
sales taxes. For example, if you select Monthly, Enterprise Solutions uses 
the previous month as the basis for your sales tax reports. When it is time 
to pay your sales tax using the Pay Sales Tax feature, Enterprise Solutions 
reminds you to make the payment.

	 Tip

	 Note
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QuickBooks Enterprise Solutions includes a Manage Sales Tax window to 
help you complete all of your common sales tax tasks, like setting sales tax 
preferences, preparing state sales tax forms, and paying sales tax. Go to 
the Vendors menu, click Sales Tax, and then click Manage Sales Tax to 
open this window.

Part 2: Setting Up Sales Tax Codes
Now you will set up the sales tax codes that you will use to track the 
taxable and non-taxable sales status of your items and customers. Later, 
you will assign these sales tax codes to your customers and the items you 
sell.

Enterprise Solutions creates two sales tax codes for you:

	 The taxable code (TAX) is assigned to items and customers that are l 
taxed.

	 The non-taxable code (NON) is assigned to items and customers that l 
are not taxed, such as non-profit organizations or items that the 
customer plans to resell.

Depending on your tax agency requirements, these two preset sales tax 
codes might be all you need to use. In which case, you do not need to set 
up any additional codes or change this preference.

If your tax agency requires you to specify additional sales tax codes to 
track taxable and non-taxable sales, such as specific tracking for out-of-
state sales, you can set them up now. (You can also set them up later when 
you need to use them.)

To set up additional sales tax codes:t 

Click the drop-down list for the type of sales tax code you want to 1	
set up (Taxable or Non-taxable) and click Add New.

In the 2	 New Sales Tax Code window, enter a sales tax code you 
want to use and a description for it.

		  Each sales tax code you add must be unique. For example, you 
might want to set up a non-taxable sales code for labor costs. You 
might enter LBR as the sales tax code and Labor, non-taxable as 
the description. Many businesses also use a non-taxable out-of-
state sales tax code (OOS).
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Click 3	 OK.

Repeat steps 1 through 3 for each sales tax code you want to add.4	

Part 3: Sales Tax Items, Rates, and Tax Agencies
You need to set up a sales tax item for each tax district (city, county, state) 
in which you sell. A sales tax item includes the sales tax rate you need to 
charge for that tax district and the tax agency to which you remit the sales 
tax you collect. Even if you sell in three different counties that all have the 
same sales tax rate, you need to set up a separate sales tax item for each 
county/rate combination so that you can properly track your sales tax 
collection and payments.

To set up your sales tax items, rates, and tax agencies:t 

In the Most common sales tax1	  field, click the drop-down arrow and 
then click Add New.

In the 2	 New Item window, click the Type drop-down arrow and then 
click Sales Tax Item.

Enter the sales tax name. (Use a name that describes the location 3	
for the Tax, such as San Mateo County. This name will appear as 
one of the choices in the Tax field on your sales forms.)

Enter a description for the way this sales tax item will appear as a 4	
line item on your sales forms (for example, San Mateo County sales 
tax). You cannot edit it on the forms themselves. Users frequently 
use the name of the sales tax item as the description.

Enter the sales tax rate (as a percentage) you charge when a sale is 5	
taxable. For example, your sales tax rate for San Mateo County 
might be 1.25% (or 1.25 cents per dollar purchased).

In the 6	 Tax Agency drop-down list, select Add New to open the New 
Vendor window, where you can set up the tax agency (a vendor) to 
which you pay this sales tax.

Enter a vendor name and contact information. For example, in 7	
California, sales tax is paid to the Board of Equalization.

Click 8	 OK to close the New Vendor window.
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Click 9	 OK to close the New Item window.

Repeat steps 1 through 9 for each local, county, or state sales tax 10	
item and rate you need to set up.

Depending on your sales tax requirements, you might need to 
combine multiple sales tax items to create a sales tax group item. 
For example, a county sales tax rate of 1.25% and a state sales tax 
rate of 7.0% would combine for a sales tax group item with a sales 
tax rate of 8.25%. Then, you can use this single sales tax rate on 
your sales forms.

When you have finished setting up all your sales tax items, choose 11	
your Most common sales tax, which is the one you charge most 
often. Remember, the most common sales tax that you charge your 
customers might be a sales tax group item.

In the 12	 Sales Tax preferences window, decide if you want to mark 
your taxable items when your sales forms are printed. If not, clear 
this checkbox.

Click 13	 OK to apply your sales tax preferences. If you have already set 
up your items and customers, you are prompted to assign a taxable 
sales tax code to all of them. Click OK if most of your items and 
customers are taxable. If not, clear the checkboxes and click OK.

	 Important
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Entering an Opening Balance for Sales Tax 
Liability
You need to enter an opening balance for your Sales Tax Liability account 
(what you owe as of your QuickBooks start date). After your start date, 
your sales tax is included on your sales forms and entered into this 
account.

Do not use this procedure if you entered historical invoices or sales receipts 
dated before your QuickBooks start date. Your sales tax will already be 
included on them and posted to this account. You can also skip this 
procedure if you entered an opening balance for each tax agency as you 
set it up.

To enter your sales tax liability for a tax agency:t 

Go to the 1	 Lists menu and click Chart of Accounts.

Double-click the 2	 Sales Tax Payable account.

In the register, find a blank transaction and fill in the details for the 3	
tax agency owed.

	 In the l Date field, enter your QuickBooks start date.

	l In the Vendor field, enter the tax agency.

	l In the Billed field, enter the amount you owed as of your start 
date.

	l From the Account drop-down list, choose Opening Bal Equity.

Cli4	 ck Record.

Rep5	 eat steps 3 and 4 for each tax agency to which you owed sales 
tax as of your QuickBooks start date.

In many states where you charge a state sales tax rate, you also need to 
charge for a city or county sales tax along with it. However, your customers 
are used to just seeing one sales tax item on their invoices or sales receipts. 
You can resolve this issue by creating sales tax group items. Once you have 
set up all of your sales tax items for your city, county, and state sales tax 
rates, you will be ready to combine the rates to create a sales tax group 
item.

	 Caution

	 Note
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Setting Up Payroll
As an employer, you have specific payroll responsibilities that are required 
by government agencies. These agencies can be federal, state or local. 
Some of these responsibilities include, but are not limited to, withholding 
amounts from your employees’s compensation to cover income tax, social 
security, Medicare, and other payments.

Choosing a Payroll Service
To manage your payroll, you first need to subscribe to a QuickBooks Payroll 
Service. QuickBooks flexible options ensure that you get the payroll service 
is right for you. Enterprise Solutions also includes payroll features that do 
not require a payroll service subscription. Refer to the in-product Help for 
more information about using payroll without a payroll service. Consult 
with a tax professional or accountant to address all your specific needs for 
your business.

You can learn about all of the payroll offerings, including manual payroll 
through the QuickBooks Payroll website.

To learn about and sign up for a Payroll Service:t 

Go to the 1	 Employees menu and click Payroll.

Click 2	 Learn About Payroll Options.

If you are not sure which payroll service is right for you, contact one of our 
payroll experts at 866.820.6382 to learn more and help you choose.

If you choose to sign up for a payroll service, you are prompted to 
complete the activation process for your service. After you complete your 
activation, you can set up payroll for your business as described in the next 
section.

	 Note
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Preparing Payroll Information
Enterprise Solutions Payroll includes an easy-to-use Payroll Setup interview 
that guides you through setting up payroll for your business. Payroll Setup 
helps you set up your employees, set up compensation and benefit 
information, as well as enter any year-to-date payroll data. The Payroll 
Setup interview also guides you through setting up scheduled payments 
for your payroll tax and non-tax liabilities (such as health insurance and 
401(K)). Scheduled payments help you manage your payroll more 
efficiently.

Before you begin setting up payroll, Intuit recommends you gather all of 
the information in the payroll setup checklist at  
http://www.payroll.com/support/PDFs/Misc/Payroll_Setup_Checklist.pdf. 
You can find this information in your own records, from your accountant or 
Enterprise Solutions Provider, or from federal and/or state agencies. 

To set up payroll for your business:t 

Go to the 1	 Employees menu and click Payroll Setup.

Follow the onscreen instructions.2	

Tip: If at any time you need to leave the Payroll Setup interview 
before completing all of your payroll setup tasks, click the Finish 
Later button. When you reopen the Payroll Setup interview, you can 
continue. To ensure accurate payroll calculations, complete your 
setup before using the Payroll.

Payroll Setup has been grouped into the following categories:

	 Company Setupl  — Enter information about the types of 
compensation and benefits you provide.

	l Employee Setup — Enter employee personal information (name, hire 
data, Social Security Number, and so on), pay information (pay rate, 
payments and deductions, paid time off balances, and so on), and tax 
withholding information (from W-4 and state forms).

	l Taxes — QuickBooks Payroll automatically sets up your state and 
federal taxes. However, you must still enter employer-specific tax rates 
(state unemployment insurance) as well as any local taxes that may 
apply.

http://www.payroll.com/support/PDFs/Misc/Payroll_Setup_Checklist.pdf
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	l Payroll History — If you have issued paychecks during this calendar 
year prior to using QuickBooks Payroll, you must provide year-to-date 
payroll history to accurately generate tax payments and filings.

After your initial payroll setup, you may need to add new employees or 
edit employee payroll information. You do not need to use the Payroll 
Setup interview for these quick tasks. Instead, follow the instructions for 
adding and editing employee information listed on page 52.

	 Note
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Setting Up Employees
Employees are people who work for your company. Employees can work 
full time or part time. To process paychecks and prepare tax documents for 
your employees, you need to enter specific information about each of your 
employees. Refer to the payroll setup checklist at http://www.payroll.com/
support/PDFs/Misc/Payroll_Setup_Checklist.pdf for a list of employee 
information to gather. 

If you have employees who need a 1099 (for example, subcontractors), set 
them up as vendors, not employees.

Generally, people in business for themselves are not employees of the 
company. However, if your company is incorporated, working corporate 
officers are considered employees. Check with your accountant or payroll 
professional to determine if the owner should be considered an employee 
and then set up the owner accordingly.

If you are a QuickBooks Payroll subscriber, you will be prompted to add all 
of your employee information during payroll setup. Use the following 
procedure to edit employee information or to add additional employees at 
a later date.

To set up an employee’s personal information:t 

Click the 1	 Employee Center icon at the top of the 
QuickBooks Enterprise Solutions window.

Click 2	 New Employee.

On the 3	 Personal tab, fill in the form.

Click the 4	 Address and Contact tab, fill in the form and click OK.

When prompted to set up the employee’s payroll information, click 5	
Leave As Is.

	 Note

	 Note

http://www.payroll.com/support/PDFs/Misc/Payroll_Setup_Checklist.pdf
http://www.payroll.com/support/PDFs/Misc/Payroll_Setup_Checklist.pdf
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To set up an employee’s personal information:t 

Click the 1	 Employee Center icon at the top of the QuickBooks 
Enterprise Solutions window.

Click the 2	 Employees tab, select an employee from the list, and then 
double-click on the name.

From the 3	 Change tabs drop-down list, click Payroll and 
Compensation Info.

Fill in the 4	 Payroll Info form.

Click the 5	 Taxes button.

Click the 6	 Federal tab and fill in the form, based on the employee’s 
W-4 information.

Click the 7	 State tab and fill in the form.

Click 8	 OK.

After you have set up your employees, refer to Paying Employees on 
page 68 to learn about paying them.
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	t Money Int

Read this chapter to learn the following essential tasks. 

	l Creating an Estimate on page 56 describes how to create estimates. 

	l Creating an Invoice on page 58 describes how to create invoices.

	l Entering Sales Receipts on page 59 describes how to enter sales 
receipts.

	 Receiving Payments on page 6l 0 describes how to receive payments.

	 Making Deposits on page 6l 1 describes how to make deposits.

3
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Creating an Estimate
An estimate is a form you use to itemize the work you propose to do or the 
products you intend to sell to a customer. Your company might use a 
different term, such as bid, grant, or proposal. Estimates are optional, not 
mandatory, for all businesses.

You can use the estimate form to prepare estimates, bids, quotes, or 
proposals for your customers. You can change the title Estimate to 
anything that suits your business.

Filling in the estimate is similar to creating an invoice. And when it is time 
to bill your customer, you can create the invoice directly from the estimate 
by clicking Create Invoice on the estimate’s toolbar. Enterprise Solutions 
then creates the invoice, with all the information from the estimate filled 
in. Later, you can create reports that compare your estimated costs and 
revenue against your actual costs and revenue to see how accurate your 
estimates are.

You can create sales orders to help you keep track of items that your 
customers have ordered but you have not yet delivered to them, for 
example because you do not have them in stock. Refer to the in-product 
Help for instructions and tips on how to use sales orders.

To create an estimate:t 

Turn on the Estimates feature (described below), if you did not do 1	
this during the EasyStep Interview.

Go to the 2	 Customers menu and click Create Estimates.

In the 3	 Customer:Job box, enter the name of the customer or job.

Select an estimate template from the 4	 Template drop-down list.

Fill in the estimate form.5	

Click Print.6	

Save the estimate.7	

	 Tip
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To turn on the estimates feature:t 

Go to the 1	 Edit menu and click Preferences.

Click 2	 Jobs & Estimates in the list on the left and then click the 
Company Preferences tab.

Click 3	 Yes to the question, Do You Create Estimates?

To display a warning when you try to record an estimate with the 4	
same number as the existing estimate, select the Warn about 
duplicate estimates numbers checkbox.

If you do progress invoicing (also known as progress billing or 5	
partial billing):

	 Make sure l Yes is selected in response to the question, Do You 
Do Progress Invoicing?

	 Specify if you want line items that have zero amounts to print on l

your progress invoice.

Click 6	 OK.
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Creating an Invoice
An invoice is the form you use to charge customers for the products and 
services they purchase from you. When your customers do not pay you in 
full at the time you provide your service or product, or when they pay in 
advance, you need to track how much they owe you. You can use an 
invoice to help you keep track of what your customers owe you (or your 
accounts receivable).

Invoices list all the details about the sale, including the services you are 
providing or the products you are selling (your items). Invoices also show 
the quantity and price or rate of each item. If you need to make automatic 
adjustments to prices (for example, discounts or markups), invoices will 
work for you.

If your customers pay in full at the time of purchase, do not create an 
invoice. Instead, create a sales receipt, described on page 59.

To create an invoice:t 

Go to the 1	 Customers menu and click Create Invoices.

From the 2	 Customer:Job drop-down list, enter or choose the name 
of the customer or job.

Click the 3	 Template drop-down arrow and then click the invoice 
template you want to use.

Click the 4	 Terms drop-down arrow and then click the sales terms that 
apply to this customer.

In the lower part of the form, enter each of the items (including the 5	
proper quantity) that the customer has purchased.

Click 6	 Print on the toolbar to print the invoice now. Optionally, you 
can select the To be printed checkbox to print the form later or the 
To be e-mailed checkbox to e-mail the form later.

Save the invoice.7	
You can create an invoice letter directly from the invoice form by clicking 
the Letters button on the Create Invoices toolbar. Refer to the in-product 
Help for more detailed information about this feature.

	 Note

	 Tip
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You can customize your invoices (or any other sales form) for your 
business. Click Customize to open the Basic Customization window, 
where you can add your company logo, change fonts and colors, and 
access more advanced options.

Entering Sales Receipts
A sales receipt is the form you use when you make a sale for which you 
receive full payment at the time of the sale. Sales receipts can include 
payments by cash, check, or credit card.

When your customers pay in full at the time they receive your service or 
product, you do not need to track how much they owe you. However, you 
might want to record the sale, calculate its sales tax, or print a receipt for 
the sale. In these cases, you can create a sales receipt.

Examples of businesses that commonly use sales receipts include beauty 
salons, pet groomers, dry cleaners, and restaurants.

If you need to track how much a customer owes you or you do not receive 
full payment at the time of the transaction, do not use a sales receipt. 
Instead, create an invoice, described on page 58.

To enter a sales receipt:t 

Go to the 1	 Customers menu and click Enter Sales Receipts.

Fill in the top part of the form, including the 2	 Customer:Job, Date, 
and Payment Method.

Click the 3	 Template drop-down arrow and then click the sales receipt 
template you want to use.

In the bottom part of the form, enter the items purchased.4	

Save the transaction.5	
You can also use a sales receipt to create a summary of sales income and 
sales tax owed. You can summarize daily or weekly sales on a sales receipt.

	 Tip

Note

	 Tip

	 Entering Sales Receipts﻿
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Receiving Payments
When you receive money from a customer, you must receive the payment 
in Enterprise Solutions so that you can record the transaction and mark 
the invoice as being paid. When you receive a payment, the accounts 
receivable records are updated, and the payment is ready to be deposited 
into an account.

To receive a payment:t 

Go to the 1	 Customers menu and click Receive Payments.

Fill in the top portion of the form, including the customer’s name, 2	
the payment amount, payment method, and the date on which the 
payment was received.

Check the column to the left of the invoice to which you want to 3	
apply the payment. You might be asked to decide how to apply the 
payment for one of the following scenarios:

	 Overpayment can become a credit or refundl

	 Underpayment can be left as is or written offl

	 Customer has unused credit to be appliedl

	 Customer has available discountsl

Choose the appropriate selection and you should see your choices 4	
reflected in total amounts for selected invoices.

		  If the customer has a discount or available credits, you can choose 
how to apply them.

Save the payment.5	
You can set a preference so that payments received either go to the 
undeposited funds account automatically, or automatically get calculated 
and applied as you select invoices in the list. To set this preference, go to 
the Edit menu, click Preferences, and then click the Company Preferences 
tab in the Sales & Customers area.

	 Tip



Intuit Inc.	 61

	 Making Deposits﻿

Making Deposits
When you receive a payment from a customer, you can either deposit the 
payment into a bank account immediately, or you can wait until a later 
time to make the deposit.

To make a deposit:t 

Go to the 1	 Banking menu and click Make Deposits.

In the 2	 Payments to Deposit window, select the payments that you 
want to deposit and click OK.

In the 3	 Make Deposits window, click the Deposit To drop-down 
arrow and then click the account to which you want to deposit the 
funds.

Verify the date and the list of payments to deposit, making updates 4	
as necessary.

If you want to receive cash back from this deposit, fill in the 5	 Cash 
Back fields at the bottom of the form.

If you want to print a deposit slip or deposit summary, click 6	 Print.

Save the deposit.7	
Just because you record the deposit in Enterprise Solutions does not mean 
that you actually make the deposit and that the money is available. You 
still need to physically deposit the money at the bank or send an online 
transfer.

	 Note
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	t Money Outt

Read this chapter to learn the following essential tasks: 

	 Paying Bills on page 6l 4 describes how to pay bills.

	 Writing Checks on page 6l 6 describes how to write checks.

	 Issuing Credits or Refunds on page 6l 7 describes how to issue credits or 
refunds.

	 Paying Employees on page 6l 8 describes how to pay employees.

4
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Paying Bills
As you purchase equipment, supplies, products, or services to run your 
business, you will also receive bills that need to be paid. Entering these bills 
in Enterprise Solutions enables you to not only track information about 
your purchases, but also to pay these bills. Enterprise Solutions remembers 
all of your unpaid bills, enabling you to easily choose the bills you want to 
pay. Enterprise Solutions then writes and saves the checks or credit card 
charges or sends the online banking payment instructions, depending on 
the payment method you choose.

To enter a bill:t 

Go to the 1	 Vendors menu and click Enter Bills.

In the 2	 Vendor field, choose or enter a new vendor.

		  Note: If an open purchase order exists for this vendor, you are 
prompted to receive against it. Click Yes to receive against one or 
more purchase orders; then, in the Open Purchase Orders window, 
click each purchase order that contains items you have received 
and are being billed for.

Specify the payment method, payment account, and payment 3	
date.

In the 4	 Amount Due field, enter the amount of the bill.

Fill in the 5	 Date, Ref. No., Terms, and Memo fields as necessary.

For expenses (money you spend to run your business, such as 6	
utilities), assign the bill to one or more expense accounts in the 
Expenses tab.

		  For items (products or services your business buys), edit items that 
were entered from your purchase order or enter new items on the 
Items tab.

Click 7	 Save & Close or Save & New to enter the transaction.
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To pay a bill:t 

Go to the 1	 Vendors menu and click Pay Bills.

All outstanding bills are displayed. To limit the number of bills 2	
displayed, click Due on or before and then the due date for the bills 
you want to display.

Click 3	 Pay Selected Bills to complete the transaction.

You do not need to use the Pay Bills window to pay your bills. You can 
enter checks, credit card payments, and cash expenditures directly in the 
appropriate account register. However, if you enter bills using either the 
Enter Bills window or the Accounts Payable register, you must use the Pay 
Bills window for your bill payment. Do not use the Write Checks window 
to pay a bill that you have entered with either of these methods.

	 Tip
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Writing Checks
You can write a check for any kind of expense that you track with 
Enterprise Solutions expense accounts and for non-inventory part, service, 
and other charge items. If you are using inventory or purchase orders, you 
can write checks for inventory part items too.

Before writing a check read the section Writing Checks Versus Paying Bills 
on page 21 to make sure you are using the correct payment method.

Do not use the Write Checks window to write a paycheck, pay your payroll 
liabilities, pay sales tax, or pay bills you have already entered in the Pay 
Bills window.

To write a check:t 

Go to the 1	 Banking menu and click Write Checks.

Click the 2	 Bank Account drop-down arrow and then click the 
account from which you want to write the check.

Fill in the on-screen check as you would a paper check.3	

Itemize your expenses (shipping charges, taxes, or other expenses 4	
not associated with any one item) on the Expenses tab.

If you are purchasing items for your inventory, enter the items on 5	
the Items tab.

Save the transaction.6	

To find and print a single check:t 

Load the blank check form into the printer.1	

Go to the 2	 Banking menu and click Write Checks.

Click the Find button and search for the check you want to print.3	

Double-click to view the check you want to print.4	

Click 5	 Print.

In the 6	 Print Checks window, choose the options you want and click 
Print.

	 Note

	 Important
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To learn how to print multiple checks at the same time, refer to the 
in-product Help.

Issuing Credits or Refunds
Use a credit memo to record a credit when a customer returns items and 
you have already recorded an invoice, customer payment, or sales receipt. 
You can also use a credit memo for an overpayment. A credit memo is a 
document that notifies a customer that you have reduced the customer’s 
balance (for example, when a customer cancels a sale, returns something, 
or overpays).

To enter a credit memo or record a return:t 

Go to the 1	 Customers menu and click Create Credit Memos/
Refunds.

In the 2	 Customer:Job field, click the customer and job for which you 
are creating the credit memo or refund check.

		  Note: If you have created more than one job for the customer, be 
sure to assign the credit memo to the correct job. You can apply the 
credit memo only to the same job for which it was created.

Click the 3	 Template drop-down arrow and then click a template.

Enter the items being returned in the line item area.4	

Describe the reason for the credit and enter the quality and rate, if 5	
applicable.

(Optional) Enter a memo for this transaction.6	

		  Note: The memo does not print on the credit memo, but it does 
appear in the Accounts Receivable and the customer registers.

Indicate whether you want to print or e-mail the credit memo to 7	
the customer. (You can choose to do both.)

Save the credit memo.8	

In the 9	 Available Credit window, choose how to use the credit:

	 Retain as an available creditl

	 Note
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	 Give a refundl

	 Apply it to an invoicel

Enterprise Solutions enters a negative amount in your Accounts Receivable 
register for the credit memo.

Paying Employees
Paying employees is a big responsibility. You have to keep track of hours, 
salaries and wages, Social Security numbers and dependents, tax rates 
and forms, vacation and sick time, bonuses and advances, as well as 
company payments to government and private pension plans. 
Enterprise Solutions provides several features and services to help you 
manage your own payroll quickly and easily.

Always use the Pay Employees window to record paychecks. 
Enterprise Solutions payroll tax forms and reports take their data from 
transactions recorded as payroll items. These transactions are only created 
when you create a paycheck in the Pay Employees window. If you do not 
use this window to pay employees, your payroll tax forms and reports will 
not be complete.

Some payroll tasks require you to subscribe to one of the Intuit Payroll 
Services. Enterprise Solutions cannot calculate payroll taxes unless you 
sign up for a payroll service. For information about your payroll options, go 
to the Employees menu, click Payroll and then click Learn About Payroll 
Options.

To print paychecks:t 

Go to the 1	 Employees menu and click Pay Employees. Specify if you 
want to pay employees using Unscheduled Payroll (generally used 
to pay bonuses and off-cycle checks) or set up Payroll Schedules.

Update the 2	 Pay Period Ends date and the Check Date values, as 
needed.

Click the 3	 Bank Account drop-down arrow to choose the account 
that Enterprise Solutions uses to record this transaction.

	 Note

	 Tip

	 Note
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Select the employees you want to pay by clicking in the column to 4	
the left of the employee’s name.

Review the paycheck information in the 5	 Enter Payroll Information 
window.

To preview or modify a paycheck, click the employee’s name to 6	
open the Preview Paycheck window. Make the necessary changes 
and click Done.

Click 7	 Continue.

Review and verify the paycheck information in the 8	 Review and 
Create [or Save] Paychecks window.

If an employee is already set up for direct deposit, select the 9	 Direct 
Deposit checkbox in the same line as the employee.

In the 10	 Payment Options section, click whether the paychecks 
should be printed or handwritten.

Click 11	 Create Paychecks.

In the Confirmation a12	 nd Next Steps window, click Print Paychecks. 
Click Send Payroll to Intuit if you are sending your payroll to Intuit 
for processing.

Intuit Payroll Services
Intuit offers a variety of payroll services to meet your needs:

	l Basic Payroll includes tools and tax tables to help you efficiently run 
your payroll and pay your payroll taxes. (Basic Payroll does not include 
payroll tax forms.)

	l Enhanced Payroll adds state tax forms, tools for tracking workers 
compensation costs, and tools for easily calculating bonuses. You can 
process payroll for up to three business entities (EINs).

	l Enhanced Payroll for Accountants includes the Enhanced Payroll 
features, plus after-the-fact payroll, client-ready reports, and the 
ability to process payroll for up to 50 specific businesses.

	l Assisted Payroll - Intuit handles your tax payment and filings for you. 

	 Paying Employees﻿
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All payroll services offer direct deposit of employee paychecks for a small 
additional fee. 

For more information about payroll services, go to the Employees menu 
and click Add Payroll Service.



Intuit Inc.	 71

	t Managing Your Businesst

Read this chapter to learn essential tasks for managing your business. 

	 Using Reports on page 7l 2 describes how to create and use reports.

	 Additional Services and Solutions on page 7l 6 describes how to 
streamline business management and automate business activities 
with additional services and solutions from Intuit.

	 Integrated Business Software on page 7l 7 describes how to grow your 
business by solving business challenges with industry-specific 
software that expands the functionality of your Enterprise Solutions 
software.

5
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Using Reports
Everything you enter in Enterprise Solutions can be found and generated 
into a report. Enterprise Solutions comes with dozens of prepared reports 
that you can run. You can use the Report Center to learn about reports 
and locate the ones that contain the information you need. After you have 
found a report, you can change its date range, customize the way it looks, 
print a copy of it, export it to Microsoft Excel, or display it on your screen.

To find and display the right report:t 

Click the 1	 Report Center icon at the top of the QuickBooks 
Enterprise Solutions window.

Click a report category from the list on the left. Reports for the 2	
selected category are displayed on the right.

You can view more sample reports by clicking the report on the left 3	
or right of the center report. Click the question mark icon to learn 
about the data and specific ways to customize the report.

When you find the report you need, click the thumbnail report icon 4	
at the bottom of the screen to view the report.

In addition to the powerful reports available in the Report Center, you can 
also use the QuickBooks Centers to get a quick snapshot of how your 
business is doing and the status of your relationships with your customers, 
vendors, and employees. For example, from the Centers you can easily see 
all of your unpaid bills, all of the invoices that your customers have not 
paid, and the detailed history of each of your customers and vendors. For 
more information about the QuickBooks Centers, refer to page 10 or see 
the in-product Help.

The Report Center describes all the available reports. Table 5 lists 10 
common questions that people ask and the QuickBooks report you can use 
to find the answer.

To Answer This Question Use This Report

How much money did my company make or 
lose over a specific period of time?

Profit & Loss Standard (In 
Company & Financial)



Intuit Inc.	 73

	 Using Reports﻿

To Answer This Question Use This Report

Which invoices or statement charges have 
not been paid and when are they due?

A/R Aging Detail (In Customers 
& Receivables)

How much does my company owe each 
vendor and are any payments overdue?

A/P Aging Detail (In Vendors & 
Payables)

What is the value of my company (assets, 
liabilities, and equity), and where can I see 
the total balance for each type of account?

Balance Sheet Summary (In 
Company & Financial)

What is the recent activity in all my 
company’s accounts, with beginning and 
ending balances for each account?

General Ledger (In Accountant 
& Taxes)

What are the total sales for each customer 
and job?

Sales by Customer Summary 
(In Sales)

Which items and/or services bring in the 
most/least income?

Sales by Item Summary (In 
Sales)

What are my company’s total expenses for 
each vendor?

Expenses by Vendor Summary 
(In Company & Financial)

Where is the information I need for my 
federal income tax forms?

Income Tax Summary Income 
Tax Detail (In Accountant & 
Taxes)

For my company’s total sales, how much is 
taxable, at what rate, and how much sales 
tax is currently due to be paid?

Sales Tax Liability (In Vendors 
& Payables)

Table 5	 Reports

Memorizing a Report
Whenever you change the settings for a report (modify it), you can 
memorize the report with the new settings and save it in the Memorized 
Report List. When you want to create a similar report, you can click the 
Memorized Report List to find it.

Enterprise Solutions memorizes the report settings, not the data in the 
report. When you display a memorized report, it applies the settings you 
memorized, but displays the latest data. For example, if the report date is 

	 Note
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set for the period Last Month and you memorize the report in September 
but recall it in December, the recalled report will have data for November, 
not August.

To memorize a report:t 

Click the 1	 Report Center icon at the top of the QuickBooks 
Enterprise Solutions window.

Open the report you want to modify and save.2	

After you have customized a report, click 3	 Memorize at the top of 
the report.

If you have changed an existing memorized report, indicate 4	
whether you want to replace the earlier report (under the same 
name) or create a new memorized report (under a new name).

In the 5	 Memorize Report window, enter a title for the report.

If you want to assign the report to a memorized report group, 6	
choose Save in Memorized Report Group and choose the group 
from the drop-down list. (You must already have the group set up 
on your Memorized Report List. You cannot create a new group 
here.)

Click 7	 OK.
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Customizing a Report
Enterprise Solutions provides many preset reports that focus on all aspects 
of your business finances. However, you might want to change the way the 
data displays or filter the report for specific information. To get the most 
out or your reports, you can:

	 Change the data range of a reportl 

	 Change the scope of a reportl 

	 Modify the appearance of a report (changing fonts or columns l 
widths)

To learn how to get the most out of your reports, go to the Report Center 
and then click the Learning link in the top-left corner of the window.
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Additional Services and Solutions
QuickBooks Business Services enable you to streamline management of 
your business and automate essential business activities.

Intuit provides the following Business Services and Software (each sold 
separately). To learn more about these business solutions, go to the Help 
menu and click Add QuickBooks Services.

	 QuickBooks Online Bankingl 

	 QuickBooks Bill Pay Servicel 

	 QuickBooks Deluxe Online Billing Servicel 

	 QuickBooks Remote Accessl 

	 QuickBooks Online Backup Servicel 

	 QuickBooks Merchant Account Servicel 

	 QuickBooks Technical Support Planl 

	 QuickBooks Checks and Suppliesl 

	 QuickBooks Employee Organizerl 

	 QuickBooks Standard Payrolll 

	 QuickBooks Enhanced Payrolll 

	 QuickBooks Assisted Payroll Servicel 

	 QuickBooks Enhanced Payroll for Accountantsl 

	 QuickBooks Point of Sale software or hardwarel 

	 QuickBooks Platinum Plus Business Mastercardl 

	 QuickBooks Customer Manager softwarel 

	 QuickBooks Client Manager softwarel 

	 Warehouse Management Enterprise Solutionsl 

	 Field Service Management Enterprise Solutionsl 
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Integrated Business Software
Grow your business by solving unique business challenges with tested, 
industry-specific software applications that expand the power and 
functionality of your QuickBooks Enterprise Solutions software. Work 
anytime, anywhere and still access your data using these tested third-
party solutions that integrate with Enterprise Solutions and help 
streamline critical business operations.

Created by credible, independent Intuit Gold and Silver Developers with 
extensive industry expertise, these task-based applications work together 
with your Enterprise Solutions, offering you a comprehensive solution that 
helps you build and better manage your business. Sample industries and 
key workflows served by these third-party applications include:

	 Constructionl  — Work more efficiently when doing complex 
estimating, project management, scheduling, and more. 

	l Manufacturing — Streamline business operations including shop 
floor management, advanced inventory and order management. Find 
applications that help you better manage your customers and EDI.

	l Nonprofit — Run your organization more efficiently through 
advanced donor management and fund accounting. Track grants, 
program costs, and donor information. 

	l Professional Services — Strengthen the management of your firm, 
including better control over client information, billing rates, project 
management, and customized invoicing. 

	 Retail — Increase the efficiency of your retail business and spend l 
more time with your customers through better inventory 
management, support for your point of sale transactions, and 
improved e-commerce efforts.

	l Wholesale and Distribution — Gain greater control over your 
business with automating route delivery, sales commission tracking, 
EDI, and more.

To find the software application that is right for your business, visit:  
http://enterprisesuite.intuit.com/support/extend-quickbooks and  
http://marketplace.intuit.com.

http://enterprisesuite.intuit.com/support/extend-quickbooks
http://marketplace.intuit.com
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	t Frequently Asked Questionst

How do I register my copy of Enterprise Solutions?
You can register online or by phone. Go to the Help menu and click 
Register QuickBooks.

How do I contact Technical Support?
Go to the QuickBooks Support website at www.qbes.com/support. Refer to 
Technical Support on page 5.

How do I purchase additional user licenses?
Enterprise Solutions allows multiple users to access the company file at the 
same time. As your company grows, you can add additional licenses 
instead of purchasing additional copies of Enterprise Solutions.

To add a license to your existing Enterprise Solutions license, go to the 
Help menu, click Manage My License, click Buy Additional User Licenses 
and then follow the onscreen instructions.

A

www.qbes.com/support
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How do I move my company file from one 
computer to another?
To move company files from one computer to another, Intuit recommends 
that you use a portable company file. The portable company file does not 
simply copy the data for your company; it compresses the data into a 
smaller file.

To move your company file:t 

Create a portable company file on the source computer:1	

	 Go to the a File menu and click Save Copy or Backup.

	 Click b Portable company file and then click Next.

	 Select the drive (hard drive, CD, or ZIP disk) where you want to c
save the portable company file. You can use the same filename 
or enter a new name.

	 Click d Save.

Take the media containing your portable company file to the 2	
computer to which you want to move your company file.

Open the portable company file on the destination computer:3	

	 Go to the a File menu and click Open or Restore Company.

	 Click b Restore a portable file and click Next.

	 Browse to select the portable company file you want to restore, c
click Open, and then click Next.

	 Browse to select and change the location and file name of the d
company file that will be created and opened from the portable 
company file. If you select an existing company file, it will be 
overwritten with the data from the portable company file.

	 Click e Save.
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How do I remove older or unneeded transactions 
from my data file?
You can use the Clean Up Company Data utility to remove transactions 
for which you no longer need to keep detailed records. You can choose to 
remove transactions as of a specific date (for example, all transactions 
date on or before 12/31/04). Optionally, you can choose to remove unused 
list items, such as obsolete customers and items.

Before removing the transactions, Enterprise Solutions creates an archive 
copy of your company file and enters general journal transactions that 
summarize the transactions being removed.

To remove older or unneeded transactions:t 

Go to the 1	 File menu, click Utilities, and then click Clean Up 
Company Data.

Select one of the options:2	

	 To remove transactions as of a specific date, click l Remove 
transactions as of a specific date and then select the date from 
the date box.

	 To remove all transactions in the file, click Remove ALL l

transactions.

Click 3	 Next and follow the onscreen instructions.

Cleaning up the data in the company file does not reduce the physical size 
of the company file.

	 Note
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How do I download and install an update or patch?
Periodically, Intuit provides updates to QuickBooks Enterprise Solutions 
that you can download from the Internet. These updates might include 
maintenance fixes and new Help information.

To download an update, go to the Help menu and click Update 
QuickBooks. Follow the onscreen instructions.

If you store your company file on a file server and also installed the 
Enterprise Solutions application on that server, you need to periodically 
run Enterprise Solutions on the server and apply patches and updates.

How do I back up or restore my company file?
Back up your company files daily. Backup copies are important insurance; 
if you should lose data for any reason, you can restore data from your 
backup copy. Enterprise Solutions enables you to back up and restore your 
data in a number of ways.

To backup a company file:t 

Go to the 1	 File menu and click Save Copy or Backup.

Choose the backup option you want, click 2	 Next, and follow the 
onscreen instructions.

To restore a company file:t 

Go to the 1	 File menu and click Open or Restore Company.

Choose the restore option you want, click 2	 Next, and follow the 
onscreen instructions.

To view detailed instructions for each backup and restore option, refer to 
the in-product Help.

Note
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What should I do if I forget my password?
QuickBooks 2004 and later releases support case-sensitive passwords. If 
you believe you are entering the correct password but still get the message 
The password you typed is incorrect, your password might include mixed-
cased characters. Try the following solutions:

	 Enter l Admin and then click OK without typing a password.

	 Enter your password with Caps Lock or Num Lock turned on or off.l 

	 Enter variations of your password, using mixed upper- and lower-case l 
characters.

	 Enter the password with a space before or after the actual password.l 

	 Type the password in a text editor, such as WordPad or NotePad, to l 
confirm that your keyboard is functioning properly.

	 Restore a pre-update backup of your file that does not have the l 
case-sensitive password. When you restore this file, you can set your 
new administrator password at the end of the update process.

If you are still unable to access your file, go to the Password Recovery 
website: www.qbes.com/passwordremoval (additional fees may apply).

Be sure to write down and save your administrator password in a secure 
place. Passwords not only protect your company data, but are also 
required to access your company file if you upgrade your version of 
Enterprise Solutions.

	 Note

www.qbes.com/passwordremoval
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How do I update my payroll to use the latest tax 
tables?
If you are a QuickBooks Payroll subscriber, you have two options for 
updating your tax tables:

	 Go to the l Employees menu, click Get Payroll Updates, and then click 
Update.

	 Turn on the l Auto-update preference. When a new tax table is 
available, it is downloaded automatically and you are prompted to 
install.

Payroll updates, which might include compliance enhancements and 
updated payroll tax forms as well as new tax tables, become available 
throughout the year. We recommend that you connect to the payroll 
service at least every 45 days to make sure you have the most current tax 
table available.

Make sure that you download and install the latest payroll update before 
you pay employees for the first time.

How do I add another company’s EIN to existing 
Payroll subscription?

To t add an EIN for another company:

Go to the 1	 File menu and click Open or Restore Company. Click 
Open a company file and then click Next. Choose the company file 
you want to add and click Open.

Go to the 2	 Employees menu, click Payroll Service Activities, and 
then click Use my existing Payroll subscription. When asked if you 
want help setting up payroll, click Yes.

Click 3	 Add To Subscription and click Next.

Enter and confirm the new EIN to be associated with your existing 4	
subscription.

Click 5	 Done.

Enterprise Solutions updates your subscription in the new company 
file. You can run payroll immediately.

	 Important
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QuickBooks Standard and Enhanced payroll subscriptions can process 
payroll for up to three businesses (EINs) on the same payroll subscription. 
QuickBooks Enhanced Payroll for Accountants can process payroll for up to 
50 EINs on the same payroll subscription.

	 Note
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	t Keyboard Shortcutst

Table 6 provides the keyboard shortcuts you can use to perform tasks 
quickly.

Keyboard Shortcuts

General Key

To start QuickBooks without a company file Ctrl (while opening)

To suppress the desktop windows

(in the Open Company window)

Alt (while opening)

Display product information about your software 
version

Ctrl + 2

Close active window Esc or Ctrl + F4

Active button (any button that has the black or 
colored selection border around it )

Enter

Save (will always perform the Record, OK, or Save 
and New action)

Ctrl + Enter

Dates Key

Next day + (plus key)

Previous day - (minus key)

Today T

First day of the week W

Last day of the week K

First day of the month M

Last day of the month H

B
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Keyboard Shortcuts

First day of the year Y

Last day of the year R

Date calendar Alt + (down arrow)

Editing Key

Edit transaction selected in register or lift Ctrl + E

Delete character to right of insertion point Del

Delete character to left of insertion point Backspace

Delete line from detail area Ctrl + Del

Insert line in detail area Ctrl + Ins

Cut selected characters Ctrl + X

Copy selected characters Ctrl + C

Paste cut or copied characters Ctrl + V

Increase check or other form number by one + (plus key)

Decrease check or other form number by one -  (minus key)

Undo changes made in field Ctrl + Z

Help Window Key

Display Help in context F1

Go to next Help topic Tab

Got to previous Help topic Shift + Tab

Display selected topic Enter

Activity Key

Copy check transaction in register Ctrl + O

Create invoice Ctrl + I

Delete check, invoice, transaction, or item from list Ctrl + D
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Keyboard Shortcuts

Find transaction Ctrl + F

Go to register of transfer account Ctrl + G

History of A/R or A/P transaction Ctrl + H

Memorize transaction or report Ctrl + M

New invoice, bill, check or list item in context Ctrl + N

Open account list Ctrl + A

Open Customer Center (Customers & Job list) Ctrl + J

Open Help for active window F1

Open list (for current drop-down menu) Ctrl + L

Open memorized transaction list Ctrl + T

Open split transaction window in register Ctrl + R

Open transaction journal Ctrl + Y

Paste copied transaction in register Ctrl + V

Print Ctrl + P

QuickReport on transaction or list item Ctrl + Q

QuickZoom on report Enter

Show list Ctrl + S

Use list item Ctrl + U

Write new check Ctrl + W

Moving Around a Window Key

Next field Tab

Previous field Shift + Tab

Beginning of current field Home

End of current field End
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Keyboard Shortcuts

Line below in detail area or on report Down arrow

Line above in detail area or on report Up arrow

Down one screen Page Down

Up one screen Page Up

Next word in field Ctrl + right arrow

Previous word in field Ctrl + left arrow

First item on list or previous month in register Ctrl + Page Up

Last item on list or next month in register Ctrl + Page Down

Close active window Esc or Ctrl + F4

Table 6	 Keyboard Shortcuts
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Index

A
Account types 29
Adding

accounts 28
customers 33
EIN for another company 84
icons to the icon bar 13
items 36
vendors 35

Additional services and solutions 76
Additional user licenses 79
Assisted Payroll 69

B
Backing up company files 82
Balance sheet accounts 31
Basic Payroll 69

C
Choosing a payroll service 49
Coach 9, 18
Creating

estimates 56
invoices 58

Credit memo 67
Credits 67
Currencies 22
Customer Center 10
Customizing Enterprise Solutions 26

D
Displaying multiple windows 12

E
EIN 11

adding for another company 84
Employee Center 11
Enhanced Payroll 69
Enhanced Payroll for Accountants 69
Entering bills 21
Expense accounts 30

G
Getting around 8

H
Home page 8

I
Icons, adding 13
Income accounts 30
In-product Help 15
Integrated Business Software 77
Intuit payroll services 69
Intuit Solution Providers 14
Issuing credits or refunds 67

L
Learning Center 18
List information 21
Live Community 19
Local help 14
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M
Making deposits 61
Moving company files 80
Multiple currencies 22

N
New accounts 29

P
Passwords 83
Patches 82
Paying

bills 64
employees 68

Payroll Center 11
Payroll services 69
Preparing payroll information 50

Q
QuickBooks Centers 10
QuickBooks Coach 9, 18

R
Receiving a payment 60
Refunds 67
Removing unneeded transactions 81
Reports 72

S
Sales receipts 59
Sales tax

codes 40, 45
payment schedule 44
preferences 43

Sample company files 23
Setting preferences 26

Setting up
employees 52
payroll 49
sales tax 40

Solution Providers 14
Subaccounts 29

T
Tax agencies 46
Technical Support 5
Third-party applications 71, 77
Transactions, removing 81
Tutorials 18

U
Updates 82
User Community 5
User licenses 79
Using Help Search 17
Using reports 72

V
Vendor Center 11

W
Writing checks 21, 66
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